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RESUMEN

La aparicion de maquinas de pequeiio tamaiio, de tan solo micras y aun
menores, y cada vez mas complejas, crea la necesidad del desarrollo de
técnicas de estudio que permitan obtener conclusiones efectivas para el

diseiio de estos dispositivos que les permita ser eficientes en su aplicacion.

En particular los cédigos comerciales de técnicas computacionales para
tratar la dinamica de fluidos, como el programa Fluent, que ademas
permiten un estudio de los efectos térmicos en el fluido, pueden ser valiosos
a la hora de analizar el funcionamiento de estas maquinas bajo estos

criterios.

En este proyecto se trata de una aplicacién concreta de este tipo de MEMS
que pretende la evacuacion de calor para la refrigeracion de una pequeiia
pared a 80 grados centigrados mediante la circulacion de agua a 20 grados

en un conducto que se haya en contacto con la pared.

Se pretende analizar lo idoneo de Fluent para esta tarea y la validez de los
resultados, asi como efectuar un analisis del campo térmico y fluido

resultante tanto en el caso estacionario como el caso pulsado.

Se analiza también la influencia del pulso en la trasferencia de calor a través
del nimero de Nusselt promedio en la zona de estudio, y la relacion de

acoplamiento entre la dinamica del fluido y los efectos térmicos.
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1. INTRODUCCION

1.1. Sistemas Micro Electrénicos Mecanicos ( MEMS )

MEMS son las siglas (Micro Electro Mechanical Systems) para
Sistemas Micro Electro Mecanicos, una plataforma tecnoldgica que se usa
para crear dispositivos diminutos, tan pequefios, como los que se miden en
unas pocas micras hasta un milimetro. Al tener la tecnologia de MEMS sus
raices en la industria de semiconductores, son fabricados tipicamente de

obleas de silicio o vidrio.

Podemos encontrar su origen en la llegada de la microelectréonica avanzada
hace dos décadas atras, que marco el comienzo de una nueva era de la
informacion y las comunicaciones, y su gran desarrollo posterior hasta el
momento actual. Se estan desarrollando tecnologias multidisciplinarias con

el objeto de satisfacer requerimientos cada vez mas complejos.

A raiz de la significacion de estas aplicaciones y del nivel de madurez de la
microelectrénica, la investigacion ha estado orientada en la dltima década al
“mundo pequeiio”, es decir, a las nuevas micro y nano tecnologias. El
progreso paralelo de la mecanica y la electronica se ha fundido en esta nueva
tecnologia, que se esta convirtiendo rapidamente en una de las tecnologias
mas prometedoras, con un potencial aparentemente ilimitado para dominar

los desarrollos tecnolégicos futuros.

Un dispositivo tipico MEMS es por tanto un microsistema integrado en una
pastilla que puede estar formado por partes mecanicas, eléctricas, opticas,

de fluido, con substancias quimicas y elementos biomédicos.

Aunque este hecho ha marcado un cierto caracter 2D en la fabricacion de
estos dispositivos, se estan dados cada dias mas pasos hacia procesos de
fabricacion 3D que realmente son los que van a permitir diseiiar verdaderas
maquinas complejas “a escala micro” y aprovechar realmente todas sus

posibilidades.
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Los productos finales pueden recibir muchos tipos de sefiales de entrada,
reacciones quimicas, acciones Opticas, la presion, la vibracion, y la
aceleracion. Estas maquinas son mas pequeiias que las convencionales que
se usan para obtener datos (como sensores), o actuar algun sistema, y por su
tamaifo tan pequeio es posible usarlos en lugares donde los dispositivos
convencionales no pueden ser colocados, como dentro del torrente

sanguineo de un cuerpo humano.

Estos nuevos sistemas con micro actuadores, micro sensores, y artefactos de
control incrustados desarrollados para guia, navegacion, control de
movimiento y visualizacion de flujo de alta resolucion pueden proveer
evidencia experimental sobre fendmenos de pequeiia escala y asi verificar
principios fundamentales en el microcosmos. Las aplicaciones en micro
fluidica contribuyen al suministro eficiente de medicinas razon por la cual
los BIOMEMS se estan ganando el interés de la comunidad de ingenieros y

cientificos.

Con la produccion masiva de MEMS que consumen minima energia y pueden
ser fabricados con poca basura quimica, estan apareciendo métodos
rentables. Permitiran que micro maquinas “inteligentes” funcionen con
desempeiios inigualables. En los casos en que la mecanica puede reemplazar
a la electronica, provee funcionalidad superior y no esta sujeta a ruido

electronico no deseado.

Un ejemplo de esto lo encontramos en el hecho de que los componentes
electronicos clasicos de redes de fibra dptica estan siendo reemplazados
ahora por interruptores MEMS oOpticos que permiten la creacion de
conjuntos de interruptores en miniatura de alta capacidad que jugaran un
rol critico en el desarrollo de interruptores opticos de gran escala en redes

de fibra dptica futuras.

El rapido desarrollo del campo de los MEMS iguala el progreso en
microelectréonica de hace treinta afios que condujo a los modernos

microprocesadores de alta potencia y computadoras ultrarrapidas.
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Es por eso que, en definitiva, estamos en un momento donde se espera que la
micro ingenieria redefina nuestro mundo y ocasione una revolucion
tecnoldgica similar a la que origind la introduccion de la microelectronica
tres décadas antes, abriéndose un nuevo abanico de multitud de nuevas
aplicaciones que tiene como consecuencia que debamos prepararnos para
abordar la obtencion del conocimiento necesario para realizar disefios en

Ingenieria con plenas garantias.

1.2 Sistema MEMS para extraccion de energia

Muchas de las MEMS en desarrollo actualmente involucran de una forma o

de otra el movimiento de un fluido y ademas efectos de trasmision de calor.

Es, por tanto, muy interesante una aproximacion a estas micro maquinas
desde desde el punto de vista de la dinamica de fluidos y la trasferencia de
calor para entender los mecanismos que suceden a esta pequeia escala y

sacar conclusiones que nos ayuden en su disefio.

Una de estas aplicaciones posible es la extraccion de energia, con una doble
lectura, tanto con el objetivo de conseguir la refrigeracion mediante la
conveccion forzada de un fluido o también con la intencion de hacer acopio
de energia mediante el “robo” de calor de una superficie caliente,

dependiendo de la aplicacion de la que estemos hablando.

Son muchas las geometrias diferentes que podemos encontrar en este
sentido. Este trabajo se va a centrar en el caso de un conducto en el que se
presenta un ensanchamiento en forma de escaléon en la direccion del flujo, lo

que se denomina en terminologia inglesa “backward facing step”.

Esta topologia resulta interesante para el propésito de este proyecto por dos
razones fundamentalmente, la primera de ellas es que podemos encontrar
este tipo de geometrias de forma habitual en este tipo de pequeiios
dispositivos y maquinas, debido a restricciones en la fabricacién que no
permiten un acabado mas fino o debido a distintos ajustes entre piezas,

ranurados, etc....
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Lo que nos lleva a la segunda razon es el instrumento de analisis que se va a
utilizar. Se pretende abordar el estudio del problema de trasferencia de

calor mediante técnicas de CFD (Computational Fluid Dynamics).

Estas técnicas de calculo numérico computarizado se han revelado muy
utiles y han demostrado ser muy efectivas para el tratamiento de problemas

del campo fluido en muchas aplicaciones.

Se quiere determinar lo adecuado del método para este tipo de escala
“micro”. Para ello se va a utilizar el programa Fluent que es bien conocido y
que ha demostrado ser de gran utilidad dando buenos resultados en

numerosos problemas fluidos.

Se han publicado trabajos previos que tratan del “backward facing step”
mediante el analisis numérico asistido por computador. Se trata por tanto

de un caso idoneo para contrastar los resultados del presente proyecto.

Ademas con el mismo fin en la bibliografia se cuenta también con datos
experimentales del perfil de velocidades y del campo fluido en condiciones

equivalentes al problema a estudio.
1.3. Objetivo del proyecto

Se pretende estudiar la trasferencia de calor de una superficie caliente que
se encuentra justo después de un escalon que se abre en direccion del flujo
en un conducto de escala microscopica (se puede pensar por ejemplo en la
superficie de un microchip electrénico que nos propongamos refrigerar

haciendo pasar agua por un conducto cuya pared esté en contacto con él).

El objeto del estudio es conocer la influencia de un pulso aplicado a la
velocidad de entrada sobre la trasferencia de calor desde la pared a
refrigerar hacia el fluido, con el propdsito de encontrar las condiciones mas
idoneas que optimicen la trasferencia de calor para optimizar de ese modo la

evacuacion de calor.
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Para ello se procedera a estudiar primero el comportamiento del fluido en
condiciones adiabaticas para comprobar la validez del modelo con los datos

experimentales.

El siguiente paso sera el caso de frecuencia angular cero, que se corresponde
por tanto con el caso estacionario, tanto para propiedades del fluido
constantes en funcion de la temperatura como para propiedades del fluido
variables con la temperatura, que supone una mejor aproximacion al fluido

real.

La viscosidad sufre una gran variacion llegando a ser del orden de un tercio a
80 grados centigrados del valor a 20 grados, y por tanto es un factor

relevante en el problema.

Y por ultimo se aborda el caso mas complejo introduciendo un pulso de
entrada de forma sinodal variable en funcion del tiempo con una frecuencia

angular y una amplitud determinadas.
1.4. Caracterizacion del flujo

Siguiendo con el supuesto del microprocesador se puede hablar de un rango
de temperaturas de 353 K en la pared caliente, que corresponden a 80
grados centigrados, una temperatura de operacion tipica de estos

dispositivos.

Se supondra una temperatura de entrada para el fluido de 293 K. Se utiliza
esta temperatura de entrada para adimensionalizar el resto de
temperaturas, por lo que tendremos wun intervalo entre 1 y 1.2
correspondiente a la temperatura de entrada y la temperatura de la pared

caliente.

Como ya se vera mas adelante, el hecho de que la viscosidad varie de forma
significativa tiene una influencia apreciable en el tamafio de la burbuja de
recirculacion y en la trasferencia de calor y por tanto su variacién ha de ser
tenida en cuenta para acercarnos de forma mas veraz al comportamiento

real del fluido.
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El rango de velocidades en el que nos movemos y las dimensiones del
problema definen el comportamiento del fluido como claramente laminar,
debido a que la influencia de la viscosidad es muy grande respecto de las
fuerzas inerciales, teniendo en cuenta que el numero de Reynolds

caracteristico ala entrada es igual a 100.

1.5. Geometria del problema

La geometria del problema en términos adimensionales es la siguiente:

L_Jous |

Figura. 1

Siendo 0.5 el diametro hidraulico de entrada, 0.5 la altura del escalon y 1 el
diametro hidraulico de salida. Se ha diferenciado en color rojo la zona que

esta a mayor temperatura, de longitud 5.

Esta geometria se obtiene al utilizar un diametro hidraulico Dh=450 micras

para adimensionalizar un problema de dimensiones tipicas.
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1.6. Mallado

El programa que se ha utilizado para el mallado de la geometria del
problema es Gambit, programa de creacion de mallado desarrollado por la

misma compaiiia y asociado a Fluent.

La complejidad del mallado suele ir asociada en gran medida a la

irregularidad o complejidad de la geometria.

En este caso al tratarse de una geometria regular y sencilla el mallado no
presenta gran dificultad, siendo ademas Gambit un programa sencillo de

utilizar en estos casos.

La malla es cuadrada con celdas de 0.02 de alto por 0.02 de ancho. Para el
caso con dimensiones siendo el diametro hidraulico de 450 micras esto

corresponde a una malla de 9 micras de alto por 9 micras de ancho.

En la figura 2 se muestra un detalle de la malla.

Fig. 2
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Para seleccionar la malla se ha probado a resolver el caso en Fluent con
varias de ellas hasta que la diferencia de resultado ha sido lo suficientemente
pequeiia. Se utiliza la malla mas sencilla que al correr el caso representa el

problema con el suficiente grado de fidelidad.
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2. CASO 0: PERFIL DE ENTRADA UNIFORME Y ADIABATICO

2.1, Hipotesis de partida

El primer caso de estudio es el mas sencillo en el que sélo se tendra en
cuenta en comportamiento del fluido al enfrentarse a la geometria del

problema.

No se consideran los efectos de la temperatura (se prescinde en Fluent de
resolver la ecuacion de la energia) y ademas el perfil de velocidad de

entrada es uniforme.

Una velocidad habitual para este tipo de aplicaciones es 0.22m/s. Se va a
suponer que esta velocidad de entrada U« es la velocidad promedio que se
encuentra aguas arriba en una zona sin perturbaciones el fluido y se va a

utilizar para adimensionalizar el caso.

Por tanto, a la hora de proporcionar el dato de entrada al modelo en Fluent el

valor de la velocidad sera un valor constante 1.

El numero de Reynolds basado en el diametro hidraulico caracteristico en la
entrada del conducto es Re=100. El flujo se caracteriza por ser laminar. A
este numero de Reynolds la influencia de la viscosidad es muy significativa

frente a los efectos inerciales.

Agrupando los parametros significativos a tener en cuenta:
Uwx=0.22 m/s; Velocidad adimensional de entrada = 1.
Re=100; Flujo laminar
Caso adiabatico.

Dh = 450 micras; Diametro hidraulico adimensional = 1
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2.2 Resultado de la simulacion

Se obtienen de Fluent graficas que permiten visualizar las lineas de

corriente y los valores que alcanza la velocidad en la componente x.

El menu que permite estas visualizaciones es Display>Contours y se puede
seleccionar en los menus desplegables la magnitud que se quiere mostrar en

la grafica.

Las lineas de corriente adoptan esta forma:

Y la componente de la velocidad en x:
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Contours af X Velocity (m/s) Jun 15, 2009
FLUENT 6.3 (2d, dp, pbns, Tam)

El flujo, como se esperaba claramente laminar a este nimero de Reynolds
moderado, pasa a estar completamente desarrollado al principio del

conducto de entrada.

También se puede apreciar en ambas imagenes la formacion de una burbuja
de recirculacion en la zona donde el fluido supera al escaléon sobre pared

caliente.

Es de interés calcular el tamaiio de esta burbuja de recirculacion. En el punto
en que la velocidad es cero, el esfuerzo tangencial debe ser cero, lo que se
puede determinar comprobando en que punto de la pared caliente se hace
cero la derivada de la componente x de la velocidad con respecto a la

coordenada y, ya que se cumple la expresion:

T:[ld—y

Se representa dicho punto de forma grafica.
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La burbuja de recirculacion por tanto es del orden de 1.4 en términos de la

longitud adimensional.

Esto concuerda plenamente con los datos que encontramos en la bibliografia
para datos experimentales y para simulaciones previas para el caso del que
el fluido sea agua con un nimero de Reynolds caracteristico a la entrada de
100.

Para los datos experimentales segun la referencia de Armaly [2] se podia
esperar un tamaiio de burbuja de 1.44 mientras que las simulaciones segin

Velazquez [1] arrojan un valor muy préximo al que se ha obtenido aqui, 1.4.

Se dispone de datos para comparar también la forma del perfil de velocidad
en secciones del conducto en la zona de la burbuja de recirculacion en x=6.28
y x=6.53.

Estas van a permitir contrastar la simulacién con los datos empiricos y

ademas entender el comportamiento del fluido en esa zona.

Las graficas resultantes son:
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1,2

0,8

0,6

Coordenaday

0,4

=0 Armaly
—&—P velocidad constante
—m—\/elazquez

-0,2 0 0,2 0,4 0,6 0,8 1

Componente x de la velocidaden x=6.28

Fig. 3 Perfil de velocidad constante x=6.28

Se puede apreciar en la zona baja de la grafica, para las los valores de y entre

0y 0.15 la zona de recirculacion donde las velocidades son negativas.
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1,2 === Armaly (experimental)
—#—P. velocidad constante
—m=\/elazquez (humérico)

Coordenaday

0 & T T T T 1
0 0,2 0,4 0,6 0,8 1

Componente x de la velocidad en x=6.53

Fig. 4 Perfil de velocidad x=6.53

Donde las lineas en color azul representan los datos experimentales, las
lineas en rojo los datos de la simulacién numérica de referencia y las lineas
en color verde representan los datos de la simulacion propia en Fluent.

Se han representado los valores adimensionales de la velocidad en el eje x y

las coordenadas en y de la geometria del conducto en el eje y de la grafica.

Se puede apreciar una gran correlacion entre las series de datos lo que lleva
a pensar que la simulacion da un buen resultado definiendo el

comportamiento del fluido.

El perfil de velocidades en la seccion de salida:
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0,6 -
-4 Perfil velocidad constante

0,4 -

Coordenaday

Componente x de la velocidad en la seccidn de salida

Fig. 5
La forma del perfil confirma que el fluido pasa a estar de nuevo
completamente desarrollado en la seccion de salida, lo que indica que la

longitud del conducto es suficiente para no afectar al estudio de la zona de

recirculacion.
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3. CASO 1: PERFIL DE ENTRADA PARABOLICO Y ADIABATICO
3.1. Hipotesis de partida

Se puede corresponder la geometria del problema a la del flujo de

Poiseuille para un conducto 2D de gran longitud.
Para este supuesto la velocidad de entrada es de tipo parabdlico.

Si la representamos en términos de la geometria adimensional del

problema se define por la ecuacion:

1
u; = —24(y* - 2Y)

El resto de condiciones corresponden a las del caso previo. Asimismo, se

puede comprobar que segun la expresion:

2
Us = § Uinax
La velocidad maxima que se obtiene de la expresion de u;para el rango de
valores de y en el conducto [-0.5, 0.5] es de 1.5, y por tanto el valor 1 es el
valor promedio de la velocidad en la entrada, que es coherente con la

simplificacion que se adopto para el caso previo.

3.2. Resultado de la simulacion

Los resultados obtenidos son muy similares al caso anterior. Esto es légico
tratandose de un flujo laminar que se desarrolla completamente en el
primer tramo del conducto, por lo que a la altura de la burbuja de

recirculacion son practicamente equivalentes.
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un 15, 2009
. pbns, Tam)

Se comprueba el tamafio de la burbuja de recirculacion que esta para este

caso entre 1.4y 1.42.
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[=—nared 353k 1

3.008+00
2.008+00
1.00e+00
-Veloc[tﬁffds)i 0.00e+00
-1.008+00
-2.008+0D

-3.00=+00

Como se puede ver,
anterior, en zona

comportamiento.

PN T T T T N T Y Y A T I T M B |

55 & B&5 7 7.6 & &5 9 95 11
¥-Coordinate (m)

£

obtenemos los mismos resultados que en el caso

de recirculacion el fluido presenta el mismo

Las graficas de los perfiles de velocidad frente a los datos experimentales son

como sigue.

1,2

=0 Armaly (experimental)
== Perfil parabolico
—@-\/elazquez (humérico)

0,8

0,6

Coordenaday

0,4

0,2

0,2 0,4 0,6 0,8 1 1,2

Componente x de la velocidad en x=6.28

Fig. 6Perfil de velocidad x=6.28
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=== Armaly (experimental)
& Perfil parabdlico
—u=\/elazquez (numérico)

Coordenaday

0 & T T T T 1
0 0,2 0,4 0,6 0,8 1

Componente en x de la velocidad e n x=6.53

Fig. 7 Perfil de velocidad x=6.53

Como se apreciaba en el caso anterior, a la altura de la = 6.28 se aprecia en
el perfil el efecto de la burbuja de recirculacion mientras que para la seccién
x=6.53 se puede apreciar que la zona de recirculacion ha quedado atras y
todas las velocidades son de signo positivo, aunque el perfil no ha llegado a

ser todavia un perfil parabdlico simétrico.

En la tabla siguiente se comparan los diferentes tamafios de burbuja para los

casos adiabaticos:

Tamaiio de la Datos Simulacién Simulacion Simulacion
burbuja de experimentales | ., mérica propia propia
recirculacion (Armaly) (Velazquez) Velocidad Velocidad
constante parabdlica
Longitud Entre Entre
adimensional 1.44 1.4 1.4-1.42 1.4-1.42
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Se puede comparar de nuevo el perfil en estas secciones con el perfil

parabdlico en la seccion de salida.

0,6 -

= Perfil parabdlico

Coordenaday

Componente x de la velocidad en la seccién de salida

Fig. 8
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4. CASO 2: PERFIL DE ENTRADA PARABOLICO. FLUIDO IDEAL,
PROPIEDADES CONSTANTES CON LA TEMPERATURA

4.1. Hipotesis de partida

En este caso se mantiene el perfil de entrada parabdlico del caso previo, y
se simula ya el efecto de la temperatura siendo el valor de la pared

caliente de 1.2 y la temperatura de entrada del agua de valor 1.

La simulacion se simplifica suponiendo que las propiedades del agua

(viscosidad, conductividad térmica) son constantes con la temperatura.

Para estimar la capacidad de refrigeracion del fluido y caracterizar la
trasferencia de calor en la zona de la recirculacion se elige un tramo
desde x=5 hasta x=7 para abarcar la burbuja y se calcula el numero de

Nusselt promedio.

En el caso no estacionario este Nu promedio variara para cada

incremento de tiempo debido a la evolucion del fluido en el conducto.

Para el caso estacionario que se analiza ahora se estima unicamente el
valor promedio local del nimero de Nusselt que es funcion de la

coordenada x.

Para el caso general se tiene la ecuacion

t=tc 1 x=7
Nupromedio = ft=0 (E fx=5 Nu,dx)dt

1T -T t
Siendo Nu,(t) = — wall—Twali+1(1)
Ay Tyan—1

Donde T,,; es la temperatura de la pared caliente y T, ;.1(t) es la
temperatura en el punto de la malla mas cercano a la pared caliente en la

direccion perpendicular a esta para cada x.
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Esto permitira valorar la influencia de la dependencia de estas
propiedades con la temperatura y su efecto en la trasferencia de calor al

comparar este caso con el caso que le sigue.

Para mantener el modelo adimensional pero que sea representativo del
caso real, de la misma forma que el numero de Reynolds debia
conservarse, al anadir los efectos térmicos se debe conservar el numero
de Prandtl.

Para ello se actua sobre las propiedades del fluido para que se conserve la

relacion:

pr=2"_667
K

En los primeros casos se modifico la viscosidad de modo que se debe
modificar de la misma manera la conductividad térmica para que el
numero de Prandtl se conserve y nuestro modelo sea equivalente
dividiendo por el diametro hidraulico caracteristico Dh= 450 micras y

por la velocidad de entrada Uco=0.22 m/s.

4.2. Resultado de la simulacion

Se obtienen las graficas siguientes para las lineas de corriente y la

componente en x de la velocidad.

Pagina
29



Microsistema para la extraccion de energia

LAle+00
43e+0D
.36e+00
.30e+DD
.23e+00
A7e+DD
A0e+0D
04e+0D
9.73e-01
9.08e-01

B8.42e-01
7.77e-01
7.l2e-01 .

1
1
1
1
1
1
1
1

B.46e-01
5.81e-01
5.168-01
4.51e-01
3.858-01
3.20e-01
2.55e-01
1.89e-01
1.24e-01
5.88e-02
-6.54e-0
-7.18e-10
-1.37e-10

Lontours af X Velocity (m/s) Jun 18, 20049
FLUENT 6.3 (Zd. dp, pbns, lam)

Se comprueba el efecto que tiene el incluir la ecuacion de la energia en el

tamaiio de la burbuja.
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[=—nared 353k 1

3.00e+010

2.008+00

1.00e+00

“Welooity/dy 0.00e+00
7' fE)

-1.008+00

-2.00e+0D0

PN T T T T N T Y Y A T I T M B |

_S-DDG-‘-UD T T T T T T T T T T T T T T T T T T T 1
55 & B&5 7 7.6 & &5 9 95 11
¥-Coordinate (m)

£

La influencia sobre el tamafio de la burbuja del efecto de la temperatura es
practicamente nula cuando las propiedades del fluido, en nuestro caso el

agua, son constantes con la temperatura y permanece en el valor 1.42.

El aspecto de la distribucion de temperaturas es el siguiente:

20e+00

le+00
.08e+00
08e+00
A7e+00
0Be+00
Ge+00
05e+00
4e+00
03e+00
2e+00
02e+00
A1e+00
00e+00

Contours af Static Temperature (k) Jun 186, 2009
FLUENT 6.3 (2d, dp, pbns, lam)
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Para calcular el nimero de Nusselt local y poder integrarlo en x se miden los
valores de temperatura desde x=5 hasta x=7 a una distancia igual al tamafio

de la malla 0.02 de la pared a 80 grados centigrados (T=1.2).

Si calculamos con estos valores el Nu,(t) podemos integrar y obtener el

valor del Nuy,;omedio quUe para este caso es independiente de t.

El valor que se ha calculado para este caso es Nup, gmedio = 5-22.
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5. CASO 3: PERFIL DE ENTRADA PARABOLICO. FLUIDO REAL,
PROPIEDADES VARIABLES EN FUNCION DE LA TEMPERATURA

5.1. Hipotesis de partida

Se va a considerar ahora la variacion de las propiedades del fluido con la
temperatura. En una de las opciones Fluent permite introducir los
términos de un polinomio en funcion de la temperatura.

En la bibliografia se dispone de las ecuaciones siguientes, que ya tienen

en cuenta la forma en que hemos adimensionalizado la temperatura:

u=1-5646(T — 1)+ 12.259(T — 1)?
k=1-0.786(T —1) +1.176(T — 1)?

Se han desarrollado a partir de los datos experimentales para el agua que

aparecen en la referencia [5] y segin se han tratado en la referencia[1].

No se ha determinado proceder de la misma forma con la densidad
debido a la variacion de la densidad del agua con la temperatura en el
rango en que se desarrolla la simulaciéon no justifica la complejidad
adicional del caculo.

Para 293 K de temperatura el valor de la densidad es 998.2 Kg/m3 y a

353 K su valor es de 971.8 Kg/m3. Es una variacion de sé6lo un 2.6%.

5.2. Resultado de la simulacion

Para las lineas de corriente se obtiene:
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La componente x de la velocidad:

1.50e+00
1.43e+00
1.36e+00
1.29e+00
1.22e+00
1.15e+010
1.08e+00
1.01e+00
9.448-01
4.76e-01
8.07e-01

f.58s-01 ——
5.69e-01 I

8.00s-01
§.31e-01
4.63s-01
3.84e-01
3.28e-01
2.56e-01
1.87e-01
1.18e-01
4.9%e-02
-1.93e-0c
-8.81e-0c
-1.57e-01
-2.26e-01

Contaurs of X Velocity (m/s) Jun 18, 2009
FLUENT 6.3 (2d, dp. pbns, lam)

La burbuja de recirculacion ahora es mayor debido fundamentalmente a las

variaciones de la viscosidad que se producen en el seno del fluido.
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[=—nared 353K

B.00e+01

4.00e+00

2.00e+00

L

Velocity/dy 0.00=+00D
(ylfsﬁ
-2.008+00 -

-4.00e+00 —

~6.00=+00

a8 & BE 7 7B

.8 8 4.5 10

¥-Coordinate (m)

En este caso la burbuja es apreciablemente mayor con un tamaiio del orden

de 1.62.

Este resultado es el que se puede esperar debido a las diferencias de

viscosidades en funcion de la temperatura.

Tamafo de la burbuja

Caso con propiedades

Caso con propiedades

de recirculacion constantes en funcion de T
Longitud
adimensional 1.42 1.62

La distribucion de temperaturas:
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20e+00

08e+00
Q7200
0Be+00
AGe+00
05e+00
4e+00
03e+00
A2e+00
02e+00
1e+00
00e+00

1
1
1
1
1
1
1
1
1
1
1
1.11e+00
1.10e+00
1.10e+00
1.09e+00
1
1
1
1
1
1
1
1
1
1
1

Contours af Static Temperature (k) Jun 18, 2009
FLUENT 6.3 (2d, dp, pbns, Tam)

En la zona de recirculacion la viscosidad del fluido es menor y la burbuja de

recirculacion es mayor.

El nimero de Nusselt promedio obtenido es Nu,,omeqio = 5-24 .

Realmente la variacion es muy pequefia con respecto al caso anterior y
viendo la distribucion de temperaturas se puede pensar que la influencia es

mas notable en zonas alejadas de la pared caliente que cerca de ella.
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6. CASO 4: CASO NO ESTACIONARIO CON PULSACION SINOIDAL
DE ENTRADA
6.1. Hipotesis de partida

6.1.1. Expresion del pulso de entrada

La expresion de la velocidad de entrada viene definida por la
expresion correspondiente a un pulso de tipo sinodal para un flujo en
un conducto 2D recto infinitamente largo de Poiseuille que se expresa

con una ecuacion diferencial.

Se puede considerar que el conducto es suficientemente largo para
que se cumpla la ecuacion y la aproximacion sea valida.

La solucion de esta ecuacion es como sigue:
u(y,t) = ul(y) + u2(y,t)
El término u1(y) es ya conocido, siendo igual a ul(y) = —24(y?* — % y)

El termino u2(y, t) es mas complejo y se puede escribir como:

ialazeiZTtwt ( 1

u2(y,t) = Real [ -

eV L & oty _ 1)]
a+1

2w

1
1 1. 5
. = ~(i2nwRe)2
Donde Y = (i2nwRe)z y a = ez( )
Si se simplifica la expresion y se expresa en funcién de los parametros
) 48 . .
W, y ay, y teniendo en cuenta que a; = ™ siendo Re el numero de

Reynolds de entrada, se puede obtener la expresion:

—aqap 1
2nw B2t(C2

u2(y,t) = [Y cos 2wt + Z sin 2ntwt]

Donde Y y Z son expresiones que se escriben en funcion de términos
de productos de exponenciales y expresiones trigonométricas que

dependen unicamente de .
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Si se definen valores para w y a,, respectivamente la frecuencia
angular y la amplitud (no dimensionales), se tiene la expresion del

pulso de entrada para esas condiciones de contorno concretas.

6.1.2. Consideraciones sobre el tiempo de un ciclo

Se ha adimensionalizado el tiempo de forma que t” es el tiempo real en

segundo de forma que el tiempo adimensional t esigualat =t~ l];;;.
En este caso los valores que se utilizan son ® =0.15y a, = 1.5.

Esta frecuencia angular define un periodo del pulso de entrada:
] , 1 1
Periodo de un ciclo = — = — =6.66
® 0.15

Se utiliza un incremento de tiempo de At=2.5 e-04.

Esto significa que para completar un ciclo son necesarios

6.66

—  — Mo . _
Yyl de pasos de tiempo = 26640 pasos

Se parte del caso anterior de forma que las propiedades son funcion de la

temperatura.

6.2 Resultado de la simulacion

La ventana donde se ha representado la componente x de la velocidad en la
entrada muestra la imagen:
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1.8000 Media de |2 componente x de la velocidad de entrada

14000

1.2000

1.0000

18000

15000

n.4000 L B e i A B R S B E B R R B B R
000 1.0000 20000 3.0000 40000 A0000 A.0000  7.0000Q
Flow Time

=

Se ve de esta manera como la velocidad de entrada es de forma sinodal y
como en el tiempo estimado se ha completado un periodo que a partir de

aqui se repetira ciclicamente.

Las figuras de las lineas de corriente nos permiten ver la evolucion temporal
del flujo y de de la burbuja de recirculacion que aparecia en el caso
estacionario y también la forma en que aparecen nuevas burbujas de

recirculacion.

La burbuja que aparece en la parte superior del conducto es incluso mayor

que la original.

Se muestran las figuras de las lineas de corriente para un nimero de saltos
de tiempo hasta completar un ciclo, de forma que se aprecia como el flujo

vuelve al punto de partida para comenzar de nuevo el ciclo.
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En total encontramos tres burbujas de recirculacion entre los tiempos 4y 5
aproximadamente, las dos ya comentadas y una mas pequeiia. La menor de
ellas justo después de la pared vertical del escalon.

Se representan en la grafica los diferentes perfiles de entrada para los

diferentes instantes de tiempo que corresponden a las lineas de corriente

mostradas.
0,6 -
== Entrada 1
0,5 —@—Entrada 2
~—Entrada 3
0,4 - == Entrada 4
——Entrada 5
0,3 -
—0—Entrada 6
Entrada 7
0,2 -
Entrada 8
Entrada 9
0,1 -
Entrada 10
Entrada 11
O . T T T T 1

Fig. 9 Perfil de velocidades en la entrada para diferentes instantes de tiempo

Se ve como el perfil parabélico varia de magnitud, creciendo hasta llegar a su
maximo en el instante 2, decreciendo a partir de este hasta llegar al perfil
del instante 7, y volviendo a aumentar de valor hasta llegar al instante

marcado como 1 de nuevo.

Si se representan de la misma forma las secciones x= 6.28 y x=6.53 para un

instante de tiempo adecuado entre 4y 5 podemos conocer la forma del
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perfil de velocidades teniendo en cuenta que podemos ver la influencia de

ambas burbujas de recirculacion:

==@==Seccion 6.53 5

——Seccion 6.28 5

1,5

Coordenaday

Componente x de la velocidad

Fig. 10 Perfiles de velocidad para t=3.125 (Instante 5)

Se calcula el nimero de Nusselt promedio resolviendo la doble integral,
primero respecto de x y después en funcion del tiempo, y se obtiene para

este caso un valor de Nu,,omedio = 6.9

Se comprueba que el hecho de introducir un pulso de entrada incide en una
mayor trasferencia del calor desde la pared caliente al agua circulante, y por

lo tanto se consigue mejorar la evacuacion de calor.

Contrastando el dato con la simulacion numérica en [1] se comprueba que el

valor obtenido de 6.9 es inferior a 8.44 que es el valor que este trabajo
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determinaba para estas condiciones de frecuencia angular 0.15 y amplitud

1.5.

Hay que tener en cuenta que la referencia [1] no aporta datos
experimentales que se contrasten con los resultados de la simulacién

numérica para el caso pulsado.
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7. CONCLUSIONES

A tenor de los resultados obtenidos y comparandolos con los resultados
publicados en trabajos previos de la referencia [1] se puede concluir que el
programa Fluent es muy valido para simular los fendmenos de trasferencia
de calor y el comportamiento del fluido a la escala del problema que se ha

tratado.

Se obtiene como ventaja la facilidad de uso y se elimina la necesidad de
programar un codigo propio para la simulacion numérica del problema a
resolver, mas costoso y dificil, y ademas sujeto a errores dificiles de verificar

cuando el fenémeno que se estudia no esta suficientemente documentado.

El usar un codigo comercial ampliamente utilizado garantiza que si se
acomete de la manera correcta el problema con las hipdtesis de partida
validas, la solucion que puede esperarse sera representativa del fenémeno

que se esta estudiando.
Se pueden destacar lo siguientes puntos:

- Para el caso adiabatico se han comparado los datos
experimentales y los datos numéricos, y esta comparacion ha
permitido comprobar la buena correlacion de los tres casos.

- Se ha comprobado que efectivamente la dependencia de la
temperatura de las propiedades del fluido establece diferencias
significativas en el tamafio de la burbuja de recirculacion y que
debe tenerse en cuenta en el analisis numérico.

- La pulsacion del flujo incide en un aumento del nimero de Nusselt
que refleja un aumento en la trasferencia de calor entre el fluido y
la superficie caliente. Se consigue asi una mejor evacuacion de

calor que en el caso estacionario.

Por otro lado, si bien se ha visto que el nimero de Nusselt del caso pulsado es

mayor que en el caso estacionario, para tener una vision real del fendmeno
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de trasferencia de calor en estas condiciones se deben realizar varios casos
mas, ya que hay discrepancias entre los valores obtenidos en ambas

simulaciones, 6.9 y 8.44.

Una vez que se ha llegado a la soluciéon del primer caso, resulta facil adaptar
los datos de entrada a otras configuraciones de los parametros que permitan
llevar el estudio un paso mas adelante llevando a cabo una casuistica que
permita comprobar la influencia real de la frecuencia de la pulsacion y la

amplitud de entrada.

Esto nos permitiria sacar conclusiones reales de como optimizar la
refrigeracion de la pared a alta temperatura, utilizando las condiciones de

entrada adecuadas.

Del mismo modo se puede afirmar que el programa debe dar buenos
resultados para geometrias tipicas diferentes que pueden permitir ampliar

el rango de posibilidades de analisis de diferentes problemas.
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8. APENDICES

APENDICE I: GAMBIT

Se resefian aqui los pasos que se ha dado en el programa Gambit para

construir la malla que ha servido para resolver el problema en Fluent.
En el menu Solver la opcién a marcar es Fluent5/6.

Para crear la geometria basica creando los puntos de los vértices, las

opciones graficas de Gambit se encuentran a la derecha de la pantalla.

En los iconos que aparecen bajo el nombre de operacion se selecciona el

primero, Geometry.

Las opciones se van presentando en cascada hacia abajo. En la siguiente fila

se puede crear un punto seleccionando Vertex.

Operation
& @] @i
_ Geometry
] g el =l
Vertex
be| @
K vﬁ &

Se despliega la ventana siguiente:
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Create Real Vertex
Coordinate Sys. Izc_sysﬂ ﬂ

Type Cartesian — |

Global Local

I
if

Label |}

Apply | Reset | Close I

Donde se introducen las coordenadas para cada punto y se pulsa Apply.

Las coordenadas de los puntos que se introducen son.

Vértice 1 (0, 0, 0) Vértice 5 (15, -0.5, 0)
Vértice 2 (5, 0, 0) Vértice 6 (15, 0.5, 0)
Vértice 3 (5, -0.5, 0) Vértice 7 (0, 0.5, 0)

Vértice 4 (10, -0.5, 0)

Se obtiene el resultado:
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Se unen los vértices con lineas rectas usando Geometry>Edge>Create

Straight Edge:

Create Straight Edge

Vertices IZ *

Type: 4@ Real . Virtual

W ion g — IE J

Label IZ

Apply | Reset | Close |

Se pueden seleccionar los vértices dos a dos con el boton derecho del raton y

la tecla Shift y pulsar Apply.

De este modo:

Para poder mallar después hay que definir sobre estas lineas una cara

mediante Geometry>Face>Create Face From Wireframe:
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Create Face From Wireframe

Edges IE *

Type: 4@ Real -~ ‘Virtual

_1 Create planar tolerant face

Apply | Reset Close

Para ello se seleccionan todas las lineas con el botdn izquierdo del raton y

Shift y se selecciona Apply.

Las lineas cambian a color azul claro cuando forman una cara.

Ahora se pueden establecer los puntos de la malla sobre la cara con la opcion

Geometry>Mesh> Mesh edges

Pagina
50



Microsistema para la extraccion de energia

Edges | ﬂ
W Pick with links Reversel
Soft link Farm — |

W Use first edge settings
Grading W Apply Defau|t|

Type  Successive Ratio —

Imvert _| Double sided
Ratio I1

I

Spacing W Apply Defau|t|

IO.C@ Interval size

Options W Mesh
_| Remove old mest
_I Ignore size functic

Apply | Reset | Close |

Se utiliza el tipo Succesive Ratio con un raatio de valor 1, es decir, intervalos

constantes de tamafio 0.02 que se introduce en la casilla Interval Size.

Seleccionamos todas las lineas y aplicamos las opciones.
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Se crea la malla con Geometry>Mesh> Mesh Faces como se muestra en la

imagen.

Faces IZ ﬂ

Scheme: W Apply Defaultl

Elements: 54 _ |

TYPe:  sSubmap — |

Spacing: 1 Apply Defaultl

Interval size

Options: M Mesh
_| Remove old mes

A T B AR W R A o DI
HIER RIS S A I

1 lgnore size functic

Apply | Reset | Close

La opcion Quad indica que se malla con elementos cuadrados regulares y el
tipo Submap que la malla se adaptara a cambios en la geometria, como por

ejemplo el escalon del problema.

Se selecciona y aplica de nuevo y se obtiene el mallado.
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Solo resta ahora definir las condiciones de frontera que se utilizaran en

Fluent. Para ello se utiliza el menu Operation>Zones>Specify Boundary

Types.
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Specify Boundary Types
FLUENT 5/6

Action:
4 Add ~ Modify

~ Delete  « Delete all

Name Type
1AL R
i
| =] 1 ] 1
_| Show labels _| Show colors
Name: IE
Type:
W ALL =
Entity:
Edges — ||I ﬂ
Label Type
<] 13 ] 1=
Remove | Edit |

Apply | Reset | Close |

Se elige tipo Wall para todas las lineas a excepcion de la entrada y salida

donde se dan condiciones diferentes.

Para la entrada se utiliza la condicion tipo Velocity Inlet para poder

posteriormente fijar una velocidad de entrada.
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Specify Boundary Types

FLUENT 5/6

Action:
~ Add @ Modify

v Delete  «r Delete all

Name Type
wall. 1 WALL A

i

_| Show labels _| Show colors

Name: vaelocity_inlet.E
Type:
WELOCITY _INLET =

Entity:

Edges — ||Iedge ﬂ

FEemove | Edit |

Apply | Reset | Close |

Para la cara de salida se establece el tipo Pressure Outlet que es la adecuada.
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Specify Boundary Types

FLUENT 5/6

Action:
4 Add v Modify
~ Delete  « Delete all

Name Type
wall. 1 WALL a
velocity inlet.2 |PRESSURE
pressure_outle |FPRESSURE.

i

1 Rl T
_| Show labels _| Show colors

Name: IE
Type:
FRESSURE_QUTLET -
Entity:
Edges — ||I ﬂ
Label Type
<] 132 =] 1]
Remove | Edit |

Apply Reset | Close |

Esta condicion nos permite en Fluent igualar la presion en la salida a la
presion deseada, que para en este caso sera simplemente la atmosférica y

que ya esta establecida por defecto en Fluent para esta condicion de

contorno.

Se graba la malla en un archivo tipo .mesh, que Fluent puede leer, en

File>Export>Mesh marcando la opcién Export 2D Mesh.
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\\ Export Mesh File

File Type: UNS /R RAMPANT / FLUENT 5/6

File Name: | msh

W Export 2-D{X-Y) Mesh

Accept | Close |

APENDICE Il: USER DEFINED FUNCTIONS

Se muestran a continuacion las funciones definidas por el usuario que se han

usado para la resolucion de la simulacion.

La primera corresponde al caso de velocidad de perfil parabdlico.

/*******************************************************************~k~k

*

parabolicoadim.c
UDF for specifying a parabolic velocity profile
R IR I b db db b dh b b S S b b SR I b S dh b S S Sh b S dh b dh Sh b S Sh b b dR Ih b S dh b SR Sb b I dh b S dh Sb b dh b b SR Sb b S db b db  Sh b g 4

*/
#include "udf.h"

DEFINE PROFILE (perfil parabolicoadim, thread, position)
{

real x[ND ND];

real

Y7
real t CURRENT_ TIME;
t

ol

face ;
begin f loop(f, thread)
{
F_CENTROID (x, f, thread) ;
y = x[11;
F PROFILE (f, thread, position)= -24* (y*y-0.5*y);
}
end f loop(f, thread)

Y en segundo lugar la que corresponde al caso pulsado:
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/*********************************************************************
*

perfil caso 33.c
UDF for specifying a unsteady velocity profile
R IR I b g db b S dh I b S db b S S I b S I I S 2R S b db b db Sb b S S b b 2R Ib b S Sb b SR Sb b 2 db I db Sb b b Ib b b SR Sb b S db I b 2b Sb b g 4

*/
#include "udf.h"

DEFINE PROFILE (perfil caso33, thread, position)
{

real x[ND ND];

real vy;

real tetha 6.8646842406;

real gamma = 0.9424778;

real k = 0.000849257;

real Al = 957.84335;

real B = -28.6500912;
real C = -8.872172441;
real D = 899.5431672;
real t = CURRENT TIME;
face t £;

begin f loop (f, thread)
{
F_CENTROID (x, f, thread) ;
y = x[1];
F PROFILE (f, thread, position)= =-24* (y*y-0.5*y) -
k* (cos (gamma*t) * (B*pow (Al, y) *sin (tetha*y) -D*pow (Al,-y) *sin (tetha*y) -
C*pow (Al,y) *cos (tetha*y) +C*pow (A1, -
y) *cos (tetha*y) ) +sin (gamma*t) * (B*pow (Al, y) *cos (tetha*y) + (D-B) *pow (Al, -
y) *cos (tetha*y) +C*pow (Al,y) *sin (tetha*y)-(D))) ;
}
end f loop(f, thread)

}

Esta se ha elaborado para poder sustituir en la definicién de constantes que
incluye los valores correspondientes a cada caso que se quiera simular para
distintos valores de la frecuencia angular y de la amplitud, que para los datos

que se muestran correspondian a 0.15y 1.5.

En los casos 13,23 y 41 que la frecuencia angular permanece constante, basta

cambiar el valor de la constante k.
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Caso 13 k=0.000141543
Caso23 k=0.000424629
Caso 41 k=0.001302195

Se incluye también la udf del caso 35, que se ha simulado para tener un caso

con una frecuencia angular diferente, de valor 0.2.

/*********************************************************************
*

perfil caso 35.c
UDF for specifying a unsteady velocity profile
R IR I b g db b dh I b S Sb b S SR I b S db b b db S b S db b i 2h Sh b S dh b b 2R Sh b S Sb b SR Sb b 2 Sb b b dh  Sb b b Ib b b 2R Sb b S 2b I b 2b Sb b b 4

*/
#include "udf.h"

DEFINE PROFILE (perfil caso35, thread, position)
{

real x[ND ND];

real vy;

real tetha 7.926654595;

real gamma = 1.25663706;

real k = 0.000212249;

real Al = 2770.144032;

real B = -34.839968;
real C = -38.54401021;
real D = 2699.464096;
real t = CURRENT_TIME;
face t f;

begin f loop(f, thread)
{
F_CENTROID(x,f,thread);
y = x[1];
F PROFILE (f, thread, position)= =24* (y*y-0.5*y) -
k* (cos (gamma*t) * (B*pow (Al, y) *sin (tetha*y) -D*pow (Al, -y) *sin (tetha*y) -
C*pow (Al,y) *cos (tetha*y) +C*pow (Al, -
y) *cos (tetha*y) ) +sin (gamma*t) * (B*pow (Al, y) *cos (tetha*y) + (D-B) *pow (Al, -
y) *cos (tetha*y) +C*pow (Al, y) *sin (tetha*y)-(D))) ;
}
end f loop(f, thread)
}
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APENDICE I1l: PROCEDIMIENTO EN FLUENT

Se describen aqui de forma resumida los pasos mas importantes que se han

dado en Fluent para lanzar las simulaciones .

Para comenzar en Fluent se procede a leer el archivo de extension .mesh que

contiene la geometria de la malla. Para comprobar que no hay ningan

problema con la esta seleccionamos la opcion:

Grid>Che

Fluent nos lista en pantalla las caracteristicas de la malla y nos confirma que

ck

todo es correcto.

El programa muestra los siguientes datos:

E FLUENT [2d, dp, pbns, lam]

=

File Grid Define Solve Adapt Surface Display Plot

Beport  Parallel Help

Grid Check

Domain Ex
x-coord
y-coord

Volume st
ninimum
maximum

total

Face area
ninimum
maximum

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Checking

Done.

tents:

inate: min {m)
inate: min {(m)
atistics:
volume (m3): 4.000000e-004
volume (m3): 4.0000008e-004
volume (m3): 1.2500008e+0681
statistics:

face area (m2): 2.000000e-0802
face area (m2): 2_008000e-8082
number of nodes per cell.
number of faces per cell.
thread pointers.

number of cells per face.

face cells.

bridge faces.

right-handed cells.

face handedness.

face node order.

element type consistency.
boundary types:

face pairs.

periodic boundaries.

node count.|

nosolve cell count.

nosolve face count.

face children.

cell children.

storage.

0.000000e+808, max (m) = 1.500008e+081
-5.000000e-001, max (m) = 5.000000e-0861

m

4

il

Para conocer el tamafno de la malla se selecciona Grid>Info>Size
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B FLUENT [2d, dp, pbins, lam] g i S = | (B

|Ei|e Grid Define Solve Adapt Surface Display Plot Report  Parallel Help

1 cell zone, B8 face Zones.

Grid Size

| Level Cells Faces Hodes  Partitions
a 31250 63300 320851 1

1} |

Para definir los datos de entrada del caso adiabatico de perfil de velocidad

uniforme se ha de acudir al menu Define>Models>Solver y activar el caso

estacionario
'E Salver &f

Solver Formulation
* Pressure Based “ Implicit
" Density Based (&

Space Time
* 2D * Steady
" Axisymmetric " Unsteady
" Axisymmetric Swirl
r

Yelocity Formulation

' Absolute
" Relative
Gradient Option Porous Formulation
* Green-Gauss Cell Based * Superficial Velocity

" Green-Gauss Node Based || © Physical Yelocity
" Least Squares Cell Based

oK | Help |

La ecuacion de la energia no se considera en el caso adiabatico y por tanto no

se activa en Fluent, la casilla queda sin marcar.

Define>Models>Energy

'g Energy Iﬁ1

Energy

[ Energy Equation

0K | ?Cancﬂlj Help |
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La viscosidad es laminar. Define>Models>Viscous

E Viscous Model [&J |
Model

" Inviscid
* Laminar
" Spalart-Allmaras [1 eqn)
" k-epsilon [2 eqn]
~
~

k-omega [2 eqn]
Reynolds Stress [b eqn]

OK | ?Cancelg Help |

Se ha de seleccionar el fuido de trabajo. Se puede acudir a la biblioteca de

Fluent para esto. Define>Materials

Seleccionamos Fluent Database y en la lista de la ventana que se abre

elegimos Water-liquid (H20<I1>).
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[ B Fluent Database Materials E——— @
Fluent Fluid Materials £| =] Material Type
vinyl-trichlorosilane [sicl3ch2ch] - |ﬂuid j
vinylidene-chloride [ch2ccl2
Order Materials By
water-vapor [h2o] & Name
wood-volatiles [wood_vol] “ Chemical Formula
< b
Properties
Denstty (kgim3) [yntony E -
998.2
Cp lifka k) |cunstant j
4182
Thermal Conductivity [w/m-k] |cunstant j
8.6
Viscosity [kg/m-s] |cunstant j
8.8a1883
‘ ‘ ‘ Copy ‘ Close ‘ Help ‘
(==

Seleccionamos Copy.

Se puede apreciar en la pantalla siguiente que ha debido modificarse a mano
el valor de la viscosidad para mantener la coherencia del problema después
de adimensionalizar la velocidad de entrada. Para que los calculos sean
correctos el nimero de Reynolds debe ser el mismo para el caso dimensional
que para nuestra simulacion. Esto significa que debemos multiplicarla
viscosidad por el diametro hidraulico y por la velocidad de entrada para que

se conserve el Re.

Dh=450 10e-06 ,Vo=0.22m/s.
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E Materials - re—— ﬁ‘
Name Material Type Order Materials By
|water—liquid |f|uid || & Name

o .
Chemical Formula Fluent Fluid Materials Chemical Formula
[h20<1> |water—|iquid (h20<1>) j Fluent Database...
User-Defined Database...
|nnne
Properties
Density [kgfm3] ‘cunstant j J
|998.2
Viscosity [kg/m-s] ‘cnnstant j
|1a.13131
Change/Create Delete Cluse Help

Seleccionamos Change/Create y cerramos la ventana.

El siguiente paso es definir las condiciones de entrada. Para ello se utiliza el

menu Define>Boundary Conditions

r A
E Boundary Conditions @
Zone Twvpe
default-interioi| | inletvent -
entrada intake-fan
fluid interface
pared 353k mass-flow-inlet
salida outflow
wall.1 outletvent
wall.2 pressure-farfield = i
wall.3 pressure-inlet
wall.h pressure-outlet
symmet
velocity-inlet &
wall i
1D
|3
Set... | Cupy".| Close | Help |
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Las caracteristicas de las paredes y de la entrada/salida ya se habian
definido previamente en Gambit, siendo la entrada de tipo Velocity Inlet y la

Salida de tipo Presure oulet.

EY Boundary Conditions Iﬁ
Zone Type
default-interiol| |inletvent -
entrada intake-fan
fluid interface
pared 353k mass-flow-inlet
salida outflow
wall.1 outletvent
wall.2 pressure-farfield = i
wall.3 pressure-inlet
wall.h pressure-outlet
symmet
velocity-inlet
wall S
1D
3
Set... | Cupy...| Close | Help |

Para la entrada hay que indicar la velocidad deseada. Seleccionamos Set y le

damos a la velocidad de la componente a lo largo de x el valor 1.

[ EY Velocity Inlet Iﬁ.'

Zone Name

|Entrada

Momentum | Thermal | Radiation | Species | DPM | Multiphase | UDS |

¥elocity Specification Method | cogmponents -

Reference Frame |phsolute

¥-Velocity [m{s] |1 constant -

constant -

Y-¥elocity [m{fs] |ﬂ

0K | ‘Cancel] Help |
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Se debe indicar también que el fluido de trabajo es el agua.

[ Boundary Conditions ﬁ
Zone Type
default-interio _
entrada solid
pared 353k
salida
wall.1
wall.?2
wall.3
wall.5
L
1D
2
Set...l Cupy...l Clusel Help |

Después de seleccionar fluid se selecciona Set y elegimos en el menu

desplegable esta opcion.
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(B Fuid =)

Zone Name
|F1uid

Material Name |water—|iquid j Edit... |

[ Porous Zone

[ Source Terms
I Fixed Yalues

Motion l Porous Zone | Reaction | Source Terms l Fixed Yalues l

Rotation-Axis Origin J
x[m]|n
Y["ﬂ|n

Motion Type |Statinnary j =

Help |

El resto de paredes se definen como tipo Wall. Para el caso adiabatico no hay

que introducir ningin dato nuevo.

Antes de comenzar a iterar definimos las condiciones de convergencia de la

solucion. Seleccionamos Solve>Monitors>Residual

Pagina
67



Microsistema para la extraccion de energia

[ & Residual Monitars &y

Options Storage Plotting

I Print Iterations (1900 o Window |g =

¥ Plot EI E‘
MNormalization lterations 1888 E‘

[ Mormalize ¥ Scale Axes... | Curves...|

Convergence Criterion

|ahsu|ute j

Check Absolute J
Residual Monitor Convergence Criteria

continuity v v 1e-87
®-velocity W v 1e-87
y-velocity ¥ v 1e-87

0K Plot Renorm

Introducimos un valor de 10e-07 para el residuo de error en el calculo por

iteracion para las tres ecuaciones, la de las velocidades en x e y, y para la

ecuacion de continuidad.

Iniciamos la simulacion en Solve>Initialize>Initialize e introducimos de

nuevo un valor de 1 para la velocidad en x.
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Q Solution Initialization &J
Compute From Reference Frame
| j * Relative to Cell Zone
" Absolute

Initial Yalues

[=]

Gauge Pressure [pascal] |l]

* ¥Yelocity [mfs] |1

Y Yelocity [m{s] |l]

=

Para comenzar las iteraciones, se utiliza el menu Solve>Iterate y establece
un valor de 2000 iteraciones para garantizar que el problema tiene tiempo
suficiente para converger. Esto ocurre cuando la diferencia entre la solucion
de dos iteraciones consecutivas es menor que el umbral que definimos como

error para todas las ecuaciones, 10e-07.

i E Iterate Iﬁﬂ

Iteration

Mumber of lterations (2 gag i‘
Heporting Interval [1g i‘
UDF Profile Update Interval |4 i‘

Iterate| Apply| Cluse| Help |
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Fluent tiene establecido por defecto First Order Upwind en el menu
Solve>Controls>Solution. De esta manera se hace una primera aproximacion

pero para obtener una mejor solucion seleccionamos Second Order Upwind.

[ Solution Cantrols ﬁ

Equations E| =| Under-Relaxation Factors

Pressure 9.5

Density |4
Body Forces |4
Momentum |g_7 1

-

Pressure-Yelocity Coupling Discretization

SIMPLE ~| Pressure [Standard - -

Momentum | TR R -

0K ‘ thault| Cancel| Help |

- -] i Ll T -

Se repiten los pasos para que el sistema efectué las de nuevo las iteraciones

y vuelva a converger.
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[ EY contours @‘
Options Contours of
¥ Node Values -
¥ Global Range |X Velocity j
¥ Auto Range
- ° °
[ Draw Profiles
[ Draw Grid Surfaces HIE
ors & default-interior -
evels setup entrada £
25 =N = linea_6.28
:I :I linea_6.53
Surface Name Pattern | jinea_nu -
Surface Types HIE
axis *
Match | clip-surf
exhaustfan
fan -
Display ‘ Cnmpute‘ Close Help

Para visualizar los resultados se utiliza el comando File>Hardcopy para
obtener y dar formato a la imagen de pantalla y poder guardarla en una
carpeta seleccionada cuando queremos mostrar por ejemplo las lineas de

corriente o cualquier otra opcion.

[ EY Graphics Hardcopy ﬁ1
Format Coloring File Type Resolution
" EPS " Color * Raster || \Width [p =
" HPGL * Gray Scale . E‘
" IRIS Image " Monochrome Height g i‘
" JPEG .
C PPM Options
" PostScript v Landscape Orientation
* TIFF v Rewverse Foreground/Background
" VRML
~
|impurt —window %u
Save... | Apply | Preview C ......... Iusr: Help

Para crear graficas se acude al menu Plot>XYPlot
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Solution XY Plot =5
Options Plot Direction % Axis Function
¥ Node Values L C T Derivatives... g
¥ Position on X Axis | * Reverse -
I Position on ¥ Axis dX-Velocity/dy 1
™ “Write to File Sh“""l ¥ Axis Function
" Order Points Curve Length -
File Data E j Surfaces

default-interior

entrada M
linea 6.28 H

linea 6.53
linea nu
Load File... i
salida -
Free Data
Plot Axes...l Cuwes...l Close | Help |

Para obtener los datos de la simulacion que ha llevado a cabo Fluent en estas

secciones se deben definir las mismas como superficies seleccionando

Surface>Line
Line/Rake Surface - » ﬁ
Options Type Number of Points
[~ Line Tool Il‘i"E= j I“] EI
Reset |
End Points
x0 [m] {528 x1 [m] |5 28|
|| ¥0(m)[-p.5 y1 (m] [g.5 |
| 0mfe  amf

Select Points with Mouse |

New Surface Name
Ilinea_ﬁ.zs

Create | Manage...l Close | Help |

Se procede de la misma manera para la seccion en 6.53.
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Se utiliza de nuevo la opcion del menu Plot>XYPlot y se escriben en un
archivo los valores obtenidos.

El procedimiento en Fluent para el caso de velocidad parabdlica es

equivalente con el afiadido de considerar el modo de definir la nueva

velocidad de entrada.

Para ello Fluent es capaz de interpretar instrucciones programadas en

lenguaje C que definen este tipo de condiciones de entrada.

Este tipo de funciones programadas sirven en general para combinarse
con el codigo del programa y permitir mejorar sus capacidades y aportar

cierto grado de personalizacion.

Se denominan sencillamente “user defined functions”, funciones definidas

“" ”

por el usuario, y se contienen en un archivo cuya extension es “.c”.

Una vez que tenemos la instruccion programada en lenguaje C en un
archivo de este tipo en Fluent se selecciona el menud Define>User

Defined>Functions >Interpreted

[ B Interpreted UDFs [th ]

Source File Name

|E:\U59r5\duan\ﬂucumer Browse...

CPP Command Name
cpp
Stack Size

[ Use Contributed CPP

Interpret Close Help

Se selecciona Display assembly Listing en el caso de que se quiera que se

muestre el proceso mientras Fluent interpreta la funcién al pulsar Interpret.

En Browse se introduce el archivo que se configurado previamente.
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A continuacion se introduce esta funcion como condiciéon de entrada y se

pulsa Ok.

o |

EY Velocity Inlet -

Zone Name

|Entrada

Momentum | Thermal | Radiation | Species | DPM | Multiphase | UDS |

VYelocity Specification Method Components <
Reference Frame |pAhsolute j

X-Velocity [m{s) | udf perfil_parabolico: ~

Y-¥elocity [m{s) |[1 constant -

1] 4 | ?Cancel} Help |

En este caso se denomina udf perfil_parabolico.
A partir de aqui se corre el caso de la misma forma que se hizo antes.

En el siguiente caso, de perfil parabdlico con propiedades del fluido

constantes con la temperatura, se debe activar la ecuacion de la energia.

i Q Energy Lﬂ_"j_J‘

Energy

v Energy Equation

(1] 4 | ‘Cancel] Help |

Hay que definir por tanto el umbral de error para las iteraciones de esta

ecuacion.
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i Q Residual Monitors ﬁ
Options Storage Plotting
[ Print lterations (1088 o Window |g =
v Plot El =
Mormalization lterations /1908 ]
| Normalize v Scale Axes... | Curves...
Convergence Criterion
|ahsu|utt: j
Check Absolute J
Residual Monitor Convergence Criteria
continuity [+ v 1e-87
*x-velocity v v 1e-87
y-velocity v v 1e-87
Energy v v 1e-87

=

0Ok Plot Renorm Cancel | Help |

e

Se aiiade la temperatura aplicable en cada condicion de contorno.
En el caso de las condiciones de entrada se da un valor de 1 a la

temperatura en la segunda pestaiia, Thermal.

[ B Velocity Inlet ' &y

Zone Name

|Entrada

Momentum Thermal lFladiatiunl Speciesl DPM l Multiphase] uDs ]

Temperature [k] |1 |cunstant j

oK | iancei| Help |
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Para la pared caliente el valor de la temperatura es 1.2.

B wall . - =

Zone Name
|pared_353k

Adjacent Cell Zone
|fluid

Momentum Thermal | Radiation Species]DPM IMuItiphaselUDS ]

Thermal Conditions

~ Heat Flux Temperature [k |1 .2 ‘cunstant j
= .

Tcmpera.lture Wall Thickness [m] |g
" Convection
" Radiation Heat Generation Rate [wfm3] |ﬂ ‘cunstant j
" Mixed

Material Name

aluminum j Edit...

OK | Cancel| Help
' Materials - me— - e — — s3]
Name Material Type Order Materials By
|water—liquid ‘fluid ~|| # Name
~ .
Chemical Formula Fluent Fluid Materials Chemical Formula
[h20<1> water-liquid (h20<1>) ~|  Fluent Database... |
User-Defined Database... |
‘nnne
Properties
Density (kg/fm3) ‘cunstant j J
|998.2
Cp lifkg K ‘cnnstant j
|u1sz
Thermal Conductivity [w/m-k] ‘cunstant j
|6ﬂﬁﬂ.61
Viscosity [kgim-s] ‘cnnstant j
|1a.13131
Change}'Create| Delete | Cluse| Help |
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En Solve>Controls>Solution se selecciona Second Order Upwind para la

energia del mismo modo que se hizo para la ecuacion del momento.

iy X
Solution Controls — ﬁ

Equations £| =| Under-Relaxation Factors

Flow
Density |4
Body Forces |4
Momentum |g_7

Discretization

| Pressure-Velocity Coupling

SIMPLE - Pressure [Srandard - =
Momentum |gecond Order Upwind -
Energy|Second Order Upwind -

0K | Dt:fault| Cancel Help |

L N o = i = N S = a 2 W a

Para calcular el niimero de Nusselt local y poder integrarlo en x se crea una
superficie desde x=5 hasta x=7 a una distancia igual al tamafio de la malla

0.02 de la pared a 80 grados centigrados (T=1.2).

Como se ha visto esto permite posteriormente listar los valores de

temperatura en esta linea para poder aplicar los datos a la expresion de

Nu,(t) y después integrar.
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En el menu de Fluent Surface>Line/Rake Surface:

& Line/Rake Surface &J

Options Type

~ Line Tool | |Line | |19 =
Reset

End Points

Amfs odmf

y0 (m] ’W y1 (m] ’—134.1187
L —

Select Points with Mouse ‘

Mew Surface Name
linea_temp

Create Manage... Close Help ‘

En Fluent se acude a Plot>XYPlot y se selecciona la superficie que se ha
creado, para almacenar los datos en un archivo mediante la funcién Write.
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B Solution XY Plot )

Options Y Axis Function

¥ Mode Values ’71 Temperature... -
[ Position on X Axis - —
™ Position on Y Axis a Static Temperature Id
v Write to File ¥ Axis Function

a
[ Order Points Grid...

Fle Deia HE #-Coordinate -
Surfaces E| =
linea temp |9

pared_ 353k
salida
| wall.1
Load File... | |wall.2 E
-, |[wall.3
wall.b &
Write... Axes... Curves... Close Help

En el caso de perfil parabdlico con fluido de propiedades variables con la

temperatura se incluyen las ecuaciones en funcion de T para estas

propiedades en forma polinémica.

Para poder utilizarlos en Fluent simplemente hay que despejar los
términos de forma que se correspondan a las potencias de T desde 0

hasta 2. Esto es, el término independiente y los términos de Ty T?2.

Hay que tener de nuevo en cuenta el factor de adimensionalizacién como

hicimos en los casos anteriores dividiendo por Dh y Uco.

En la ventana de propiedades pulsamos editar y seleccionamos

Polynomial.
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[ E Polynomial Profile lﬁ1
Define In Terms of Coefficients
|Ui£[:u£ity |Temperature j |3 i‘
Coeflicients
1]191.5324 2|-305.6008 3 [124.1997 1|

°| °l Il °l

Help |

Las casillas se rellenan con el factor que multiplica las potencias de T que

tienen un orden creciente T, T1, T?, etc.

Se hace de igual forma en ambos casos y se selecciona Change/Create.

.g Materials I&
Name Material Type Order Materials By
|water—liquid ‘ﬂuid +| | # Name

~ .
Chemical Formula Fluent Fluid Materials Chemical Formula

[h20<1> ‘water—liquid (h2o<1>) j Fluent Database...

User-Defined Database...
‘nune J

Properties

Density (kg/m3] ‘cnnstant

|993 .2

Cp litkg-K) ‘ constant

|u132

Thermal Conductivity [wfm-k] ‘pulynnmial

Viscosity [kg/m-s] ‘pnlynumial

Change{Create | Delete | Close | Help |

Se lanza el proceso de iteracion hasta que la soluciéon converge.

Por ultimo se simula el caso pulsado no estacionario.
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Se parte del caso anterior de forma que las propiedades son funcion de la

temperatura.

Se crea una nueva funciéon definida por el usuario para contener la

expresion que se ha visto en el punto precedente y que Fluent pueda

interpretarla como se vio anteriormente.

En esta ocasion el “solver” a utilizar es el apropiado para el caso no

estacionario, y se marca la opciéon “unsteady”.

" Axisymmetric
T Axisymmetric Swirl
~

Yelocity Formulation

* Absolute
" Relative

Gradient Option

* Green-Gauss Cell Based
" Green-Gauss Mode Based
" Least Squares Cell Based

'E Saolver [—“;"-J'
Solver Formulation
® Pressure Based * Implicit
" Density Based &
Space Time
« 2D " Steady

* Unsteady

Transient Controls

[~ Mon-lterative Time Advancement
[ Frozen Flux Formulation

Unsteady Formulation
i
* 1st-Order Implicit

" 2nd-Order Implicit
Porous Formulation

* Superficial Yelocity
" Physical Yelocity

Para visualizar la evolucion del perfil de la velocidad de entrada con

respecto del tiempo

en

una grafica se puede

utilizar

Solve>Monitors>Surface y se despliega la ventana Surface Monitors
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Surface Monitors ﬁ
Surface Monitors |1 i‘

Name Plot Print ¥rite Every When —
ventcaso3s ¥ | ¥ |1 i |Time Step  ~| Define...
monitor-2 I I [ |1 = |iteration

monitor-3 I I [ |1 = |iteration

monitor-8 | I [ |1 = |iteration -

Help

Se marcan Plot y Write para que nos muestre la evolucion en una ventana
en pantalla y ademas guarde los datos en un archivo, y se selecciona

Define.

Seleccionando Time Step el programa actualiza los datos cada salto de

tiempo, que se definira en la ventana Iterate mas adelante.

Define Surface Monitor ﬁ1
Name Report of
ventcaso33d Yelocity... -
Report Type * Velocity -
Area-Weighted Average j Surfaces =| =
X hois default-interior o
Flow Time ~ L
J linea_6.28 [
Plot Window linea_6.53 y
1 i‘ linea_nu
pared 353k S
File Name
|uentc35033.uut
0K Curves... Axes... Help

En esta ventana se le indica a Fluent que tome la media de los valores de

la componente x de la velocidad en la superficie de entrada y que los
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represente en funcion del tiempo (Flow Time), que ademas de mostrarse

en pantalla se grabara en un archivo .out.
Se pulsa Ok en ambas ventanas.
Para poner a iterar el problema se vuelve a Solve>Iterate.

La ventana para configurar las iteraciones presenta nuevas opciones para
introducir el paso del tiempo y el nimero de pasos que se quieren

realizar en la simulacion.

El nimero de iteraciones se define para cada paso de tiempo. Cuando este
converge se pasa al siguiente paso hasta que se alcanza el numero de

pasos, en este caso 250, que se desea completar.

E tterate &J‘

Time

Time Step Size (5] [g_poos2s
Number of Time Steps |25 il

Time Stepping Method

™ Fixed i
" Adaptive [
~

Options

[ Data Sampling for Time Statistics

Iteration

Max lterations per Time Step |25 a4 il
Reporting Interval [1p il
UDF Profile Update Interval |4 il

Iterate‘ Apply| Cluse| Help ‘

Un valor pequeiio del incremento o paso de tiempo significa que la solucién

es mas exacta pero también una simulaciéon mas larga.
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Para ir extrayendo los datos que vayan siendo de interés hacer el proceso a
mano, esto es, esperar a la convergencia para extraer las graficas y archivos

de datos, no es optimo y supone mucho tiempo perdido innecesario.

Fluent ofrece la posibilidad al usuario de utilizar la funcionalidad llamada
journal, que permite la repeticion de acciones establecidas de forma ciclica

hasta acabar la simulacion en un nimero determinado de pasos.

La informacion necesaria para elaborar el journal, tanto escribiendo las
lineas a mano como mediante la interfaz grafica, se almacena en un archivo

de extension .jou.

Leyendo el archivo .jou desde el meni Read>Journal se puede lanzar el
proceso de simulacion mas el registro simultaneo registro de datos en
archivos ubicados en carpetas definidas para ese fin que se han incluido en el

journal.

Se tiene asi lo necesario para el analisis y evaluacion de los datos.
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APENDICE IV: OTROS CASOS

Para complementar el caso estudiado se han realizado simulaciones de

algunos casos mas variando los parametros de entrada.

Se conserva la frecuencia angular de valor 0.15 y se introducen diferentes

valores de la amplitud.

Frecuencia Amplitud Nusselt Nimero del
angular promedio Caso

0.15 0.25 5.67 13

0.15 0.75 6.01 23

0.15 1.5 6.9 Caso principal
0.15 2.3 7.8 41

Se observa que el mayor Nusselt promedio no es para el caso que se resolvié
anteriormente en el trabajo para la misma frecuencia, sino que aumenta

todavia con una amplitud mayor, de valor 2.3 para el caso 41.

Esto no se corresponde con las conclusiones, pero en la referencia [3], sin
embargo, encontramos para los datos experimentales de la figura 12 de la
pagina 18 que el valor del niimero de Nusselt crece con la amplitud del caso,

hasta que las variaciones son muy pequeiias.

Se cumple en ambos casos que el Nusselt promedio maximo se situa
alrededor de wuna frecuencia angular concreta, pero a diferencia de la
referencia de lo que ocurre en la referencia [1], no decrece para mayores

valores de la amplitud para la misma frecuencia.

Esto se corresponde con los casos que se han simulado aqui, para los cuales
para una misma frecuencia una mayor amplitud incide en un mayor numero

de Nusselt.

Se muestran las lineas de corriente de los casos 13 y 23 que se pueden

comparar con la bibliografia.
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Para el caso 13 las lineas de corriente tienen la forma:
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Y las lineas correspondientes al caso 23 son:

El caso 35 tiene una frecuencia angular de 0.2 (y por lo tanto el periodo es 5)
y una amplitud de 1.5.

Se puede observar que el hecho de que la frecuencia sea mayor no implica un
mayor valor del Nusselt promedio, para el que se ha obtenido un valor de 6.8.
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